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INTRODUCTION

Welcome to VMware Express for Linux Systems. VMware Express is a fast and flexible way to 
run your Windows applications under Linux. It gives you a virtual Windows 98 or Windows 95
computer running in a window on your Linux desktop.

The first section of the Getting Started Guide will step you through the basics of installing a 
Windows 98 or Windows 95 guest operating system for use with VMware Express. The guide 
also provides technical notes to help you get the most out of VMware Express.

For additional documentation and other support resources, please visit the VMware support site
on the Web at http://www.vmware.com/support/express/.

The key steps in getting started with VMware Express are:

1. Install VMware Express.

2. Use the Configuration Wizard to configure your virtual machine.

3. Install Windows 98 or Windows 95 inside the virtual machine.

4. Install VMware Tools inside the virtual machine.

5. Install and use your choice of Windows applications.

Before you begin, be sure you have:

• A computer and host operating system that meet the system requirements for running 
VMware Express.

• VMware Express CD-ROM disc

• The included registration card, with your serial number.

• Installation CD or disks for your guest operating system.

SYSTEM REQUIREMENTS

Hardware requirements for the host machine 

• Standard x86-based PC

• Pentium II 266MHz and faster recommended. 
Compatible processors include: 

• Intel Pentium III, Pentium II, Celeron, and Pentium Pro
• AMD™ Athlon™, K6®, and K6-2

• Multiprocessor systems supported

• 128MB RAM recommended, 96MB minimum

• Super VGA video adapter supported by the XFree86 Server (to take advantage of the VMware 
full-screen option)

• 8MB disk space for VMware Express software installation
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• Additional disk space required for the guest operating system and Windows applications. 
Typical installaions requires:

• 210MB for Windows 98 SE
• 165MB for Windows 98 SE
• 90MB for Windows 95 OSR2
• 55MB for Windows 95

• Double-speed or faster CD-ROM drive

Software requirements for the host machine

• Standard Linux distribution with X server, glibc version 2 or higher, and one of the following:
• For single-processor systems: kernel 2.0.32 or higher kernel in the 2.0.x series, or 

kernel in the 2.2.x series.
• For SMP systems: kernel in the 2.2x series

Note: VMware Express has been tested with host systems running:
• Red Hat Linux 5.x, 6.x and 7.0
• Caldera OpenLinux 2.2 and 2.3
• SuSE Linux 6.x and 7.0
• TurboLinux 6.0

VMware may run on other Linux distributions; attempting to do so is recommended for expert 
Linux users only.

Note: glibc must be installed on your host system. In general, if a file called lib-names.h exists
in the /usr/include/gnu directory, then glibc is most likely installed; otherwise install it.

• VMware Express requires an X server
• XFree86-3.3.3.1 or higher release
• XFree86 server version 3.3.4 or higher recommended

If you are using a recent Linux distribution, it should include an appropriate X server by 
default. If you want to find out what XFree86 server is running on your computer, as root, 
run X -version.

Software for the virtual machine

• Guest operating system
• Windows 98 Second Edition
• Windows 98
• Windows 95 (retail and OSR releases)

• Optional Windows applications
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INSTALL VMWARE EXPRESS

Fastest Installation Method  

This section describes the fastest method of installing the software using the VMware Express 
CD-ROM disc. It is also possible to install the software from the tar and RPM packages on the
VMware Express CD. If you would like to install VMware Express using the tar file or RPM 
packages, please skip ahead to the corresponding sections below.

The steps below describe how to install VMware Express from the ‘vmware-distrib’ directory on
the VMware Express CD onto your Linux host system:

1. You should be logged on to your Linux host with the user name you will use when running
VMware Express.

2. Insert the VMware Express CD in your CD-ROM drive. You may have to mount it manually if
your Linux system does not automatically mount the CD. To mount the CD manually follow 
the steps below:
a) become the super user (root) by typing su
b) make CD accessible to Linux using the following command:
mount -t iso9660 -o mode=0755 /dev/cdrom /mnt/cdrom

3. Change to the [path to your CD-ROM]/vmware-distrib directory on
the CD.

4. If you are not logged in as the super user, do so by typing su

5. Start the installation by typing ./vmware-install.pl
Note: This script can be used to reconfigure VMware Express whenever you upgrade your 
kernel. It is not necessary to reinstall VMware Express.

6. Acknowledge the end user license agreement (EULA). You may page through it using the 
space bar key. If you do not get the Do you accept ... prompt, you may press Q to get to 
the next prompt.

7. If you already have Samba running on your host computer, when the configuration script 
prompts you Do you want this script to automatically configure your system to allow your 
virtual machines to access the host file system? Answer No. If Samba is not already running 
on your host computer, answer Yes to this question and the VMware installer will 
configure it for you.

8. Press Enter to display the Samba license information. You may press the space bar to page 
through it, then press Q to continue to the next prompt.

9. The configuration script asks Do you want this script to probe for an unused subnet?
Answer Yes. If the probe is not successful, the script will ask you to supply the needed 
information for the subnet that your virtual machines will use.

10. Press Enter to display the DHCP server copyright information. You may press the space bar 
to page through it, then press Q to continue to the next prompt.

11. The configuration script will prompt you for a user name and password to use with the 
Samba configuration. Enter the user name you used in step 1 above.

12. Return to your user account by typing exit. At this point you should be logged in with the 
user name you will use when running VMware Express.

You are now ready to license VMware Express. Proceed to the section titled LICENSE THE
SOFTWARE later in this chapter.
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RPM Installation Method

The steps below describe how to install the VMware Express RPM package from
the CD onto your Linux host system:

Note: If you download a newer RPM package for VMware Express, refer to 
http://www.vmware.com/support/express/ for installation instructions.

1. You should be logged on to your Linux host with the user name you will
use when running VMware.

2. Insert the VMware Express CD in your CD-ROM drive. You may have to mount
it manually if your Linux system does not automatically mount the CD. To
mount the CD manually follow the steps below:
a) become the super user (root) by typing su
b) make CD accessible to Linux using the following command:
mount -t iso9660 -o mode=0755 /dev/cdrom /mnt/cdrom

3. Change to the [path to your CD-ROM]/ directory on the CD.

4. If you are not logged in as the super user, do so by typing su

5. Install the RPM package by typing the following command:
rpm -Uhv VMware-express-2.0.3-<xxx>.i386.rpm
where <xxx> is the build number of the RPM package on your CD.

Note: VMware Workstation and VMware Express for Linux use the same RPM package 
names. RPM looks at the version and build numbers to determine which is newer.

As a result, you may receive a message that says something like Package <A> (which is 
newer than <B>) is already installed. where <A> is the program already installed on your 
computer and <B> is the program you are attempting to install.

If this happens, you can force RPM to install the “older” version with the command:
rpm -Uhv filename.rpm – oldpackage
where filename.rpm is the file you want to install.

6. Run the configuration script by typing the following command:
vmware-config.pl

Note: This script can be used to reconfigure VMware Express whenever you upgrade your 
kernel. It is not necessary to reinstall VMware Express.

7. Acknowledge the end user license agreement (EULA). You may page through it using the 
space bar key. If you do not get the Do you accept ... prompt, you may press Q to get to the
next prompt.

8. If you already have Samba running on your host computer, when the configuration script 
prompts you Do you want this script to automatically configure your system to allow your 
virtual machines to access the host file system? Answer No. If Samba is not already 
running on your host computer, answer Yes to this question and the VMware installer 
will configure it for you.

9. Press Enter to display the Samba license information. You may press the space bar to page 
through it, then press Q to continue to the next prompt.

10. The configuration script asks Do you want this script to probe for an unused subnet?
Answer Yes. If the probe is not successful, the script will ask you to supply the needed 
information for the subnet that your virtual machines will use.
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11. Press Enter to display the DHCP server copyright information. You may press the space bar
to page through it, then press Q to continue to the next prompt.

12. The configuration script will prompt you for a user name and password to use with the 
Samba configuration. Enter the user name you used in step 1 above.

13. Return to your user account by typing exit. At this point you should be logged in with the 
user name you will use when running VMware Express.

You are now ready to license VMware Express. Proceed to the section titled LICENSE THE
SOFTWARE below in this chapter.

Tar File Installation Method

The steps below describe how to install the VMware Express tar file from the CD onto your Linux 
host system:

Note: If you download a newer tar file for VMware Express, refer to 
http://www.vmware.com/support/express/ for installation instructions.

1. You should be logged on to your Linux host with the user name you will use when running 
VMware.

2. Insert the VMware Express CD in your CD-ROM drive. You may have to mount it manually if 
your Linux system does not automatically mount the CD. To mount the CD manually follow 
the steps below:
a) become the super user (root) by typing su
b) make CD accessible to Linux using the following command:
mount -t iso9660 -o mode=0755 /dev/cdrom /mnt/cdrom

3. Change to the top-level directory on the CD.

4. Copy the tar file on the CD to a directory on your hard drive. For example, to copy the file 
to your system’s /tmp directory, type the following command:
cp VMware-express-2.0.3-<xxx>.tar.gz /tmp
where <xxx> is the build number of the tar file on your CD.

5. Change to the directory where you copied the file. For example, you can change into the 
/tmp directory by typing cd /tmp

6. Extract the tar file by typing the following command:
tar zxf VMware-express-2.0.3-<xxx>.tar.gz

7. Change directories to the VMware Express installation directory, by typing the following 
command:
cd vmware-distrib

8. If you are not logged in as the super user, do so by typing su

9. Start the installation by typing ./vmware-install.pl

Note: This script can be used to reconfigure VMware Express whenever you upgrade your 
kernel. It is not necessary to reinstall VMware Express.

10. Acknowledge the end user license agreement (EULA). You may page through it using the
space bar key. If you do not get the Do you accept ... prompt, you may press Q to get to
the next prompt.
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11. If you already have Samba running on your host computer, when the configuration script 
prompts you Do you want this script to automatically configure your system to allow your 
virtual machines to access the host file system? Answer No. If Samba is not already 
running on your host computer, answer Yes to this question and the VMware installer 
will configure it for you.

12. Press Enter to display the Samba license information. You may press the space bar to page 
through it, then press Q to continue to the next prompt.

13. The configuration script asks Do you want this script to probe for an unused subnet?
Answer Yes. If the probe is not successful, the script will ask you to supply the needed 
information for the subnet that your virtual machines will use.

14. Press Enter to display the DHCP server copyright information. You may press the space bar 
to page through it, then press Q to continue to the next prompt.

15. The configuration script will prompt you for a user name and password to use with the 
Samba configuration. Enter the user name you used in step 1 above.

16. Return to your user account by typing exit. At this point you should be logged in with the 
user name you will use when running VMware Express.

You are now ready to license VMware Express. Proceed to the section titled LICENSE THE
SOFTWARE later in this chapter.

LICENSE THE SOFTWARE

This section describes how to license the software using the serial number on the included 
registration card. 

1. You should be logged on to your Linux host with the user name you will use when running 
VMware Express.

2. Locate the serial number on the registration card included in the VMware Express package. 
You will need the serial number to license the product in the next step. Keep the serial 
number in a safe place after use.

3. Start VMware Express by typing vmware from within a terminal window.

The first time you run VMware Express, you will be prompted to enter the 20-character 
serial number located on the registration card. Enter your serial number and click OK.

Once you have entered the serial number, it will be saved in your license file and VMware 
will not ask you for it again. For your convenience, VMware will automatically send the serial 
number to the VMware Web site when you use certain Web links built into the product (for
example, Help > Register Now! and Help > Support). This allows us to direct you to the 
correct Web page for registration and support for your product.

You are now ready to configure a virtual machine using VMware Express. Proceed to the next 
section titled CONFIGURE A VIRTUAL MACHINE.
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CONFIGURE A VIRTUAL MACHINE

1. VMware Express should be already running. If not make sure you are logged on your Linux 
host with the user name you will use when running VMware Express, then start VMware by 
typing vmware.

2. Start the configuration wizard.

When VMware Express is started, the startup screen has three options:
• Run the Configuration Wizard
• Run the Configuration Editor
• Open an existing configuration

The default selection is Run the Configuration Wizard. 

Click the OK button to start the Configuration Wizard. The Configuration Wizard can also be 
started from the File menu (select File > Wizard). 
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The Configuration Wizard will present you with a series of screens that you navigate using the    
Next and Prev buttons at the bottom. At each screen, follow the instructions, then click the 
Next button to proceed to the next screen. 

There is also a Finish button, which is initially dimmed. When there is enough information 
for the Configuration Wizard to finish the configuration, this button displays. Click the Finish
button to have the configuration wizard fill in all of the remaining options with default values.
Clicking Finish is the fastest way of configuring your virtual machine. 

Click the Help button to open a pop-up window with context-sensitive help. That text will 
also include links to relevant help topics (text in blue – clicking on it will take you to the 
corresponding help topic). 

VMware Express stores your virtual disk file and other files associated with your virtual 
machine together in one directory. Each virtual machine should have its own directory. The 
default location is the directory ~UserHome/vmware/VM or /home/UserHome/vmware/VM
where UserHome is the currently logged in user's name. 

If you create more than one virtual machine, you will need to specify a different directory for 
each additional virtual machine. Enter the path to the new directory in the appropriate 
screen in the Configuration Wizard and the wizard will create the directory for you.

Note: VMware Express allows you to run only one virtual machine at a time.
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3. Select the size of the virtual disk. 

Fill in the size of the virtual disk that you wish to create. Select 2000 (megabytes). 

The size should be large enough to hold the guest operating system and all of the software 
that you intend to install in the virtual machine, with room for data and growth. There is no 
way to increase this number later, although you can install additional virtual disks if you run 
out of space on this one. You will typically need about 500MB of actual free space on the file
system containing the virtual disk to install Windows 98 and popular applications such as 
Microsoft Office inside the virtual machine. 

4. Enable the CD-ROM drive. 

Select CD-ROM Enabled. Type in the path to the CD-ROM device, for example, 
/dev/cdrom. 

You will need to use your CD-ROM drive when you install the guest operating system. 

If you wish, you can disable access to the CD-ROM drive later using the Devices menu or 
from the Devices tab in the VMware Tools inside your running virtual machine. 

5. Enable the floppy disk drive.



1-10
www.vmware.com

Installing and Configuring VMware Express

Select the Floppy Enabled option and choose the device that corresponds to your physical 
floppy drive, for example, /dev/fd0. 

You may need to use the floppy drive while you are installing your guest operating system. 
If you wish, you can disable access to the floppy disk drive later using the Devices menu or 
from the Devices tab in the VMware Tools inside your running virtual machine. 

6. Configure the networking capabilities of the virtual machine. 
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Selecting Bridged and Host-Only Networking will enable your virtual machine to use both an    
existing Ethernet connection on your host computer and also a virtual network limited to 
the host and the virtual machines running on the host. 

For more details about VMware Express networking options, see the tech note on 
Networking in this guide.

Note: The VMware Samba server can give your guest operating system access to files on your 
host computer. For details, see the tech note Using Samba for File Sharing in this guide.
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7. Review and finish the configuration.

This final screen presents all the options you have selected. Review it for accuracy and click 
the Done button to complete the virtual machine configuration. 

INSTALL A GUEST OPERATING SYSTEM

With VMware Express, you can run Windows 98 and Windows 95 guest operating systems. If you
want to run other guest operating systems – including Windows NT, Windows 2000, Linux, and
FreeBSD – you should upgrade to VMware Workstation. Select Help > VMware Workstation
Upgrade offer!

Windows 98 Installation Guidelines and Known Problems 

Windows 98 can be installed in a virtual machine using the standard Windows 98 CD. 

Note: Some Microsoft Windows 98 OEM disks included with new computers are customized for 
those computers and include device drivers and other utilities specific to the hardware system.
Even if you can install this Windows 98 operating system on your actual computer, you may not be
able to install it in a VMware Express virtual machine. You may need to purchase a new copy of
Windows to install in a virtual machine. 
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The instructions below are for the simplest case of one virtual IDE hard drive and one virtual IDE 
CD-ROM drive. If you have configured the virtual machine with more than one IDE hard drive,
you should also fdisk and format these drives before installing Windows 98. If you have
configured the virtual machine with more than one virtual hard drive or one virtual CD-ROM, you
may need to use different device letters than those in the instructions below. 
Before installing the operating system, be sure that you have already created a new virtual
machine and configured it using the VMware Express Configuration Wizard. 

While you are installing the guest operating system, you can click anywhere inside the VMware 
Express window to give the virtual machine control of your mouse and keyboard. If you want the
virtual machine to release the mouse and keyboard so you can access your Linux desktop again,
press Ctrl-Alt-Esc.

Windows 98 Installation Steps 

1. Use the VMware Express Configuration Editor to verify the virtual machine's devices are set 
up as you expect before starting the installation. For example, if you would like the Windows
98 setup program to install a sound driver, be sure that sound is enabled in the virtual 
machine's configuration. VMware also recommends that you disable the screen saver on the
host system before starting the installation process. 

2. Insert the Windows 98 CD in the CD-ROM drive.

3. Power on the virtual machine to start installing Windows 98. 

4. Choose to boot from CD-ROM, then select Start Windows 98 Setup from CD-ROM. The setup 
program will run fdisk and reboot. 

5. Choose to boot from CD-ROM, then select Start Windows 98 Setup from CD-ROM. The setup
program will continue installing Windows 98. 

6. Follow the Windows 98 installation steps as you would for a real PC. 

Installing VMware Tools

After Windows has been installed, skip ahead to install the VMware Tools, as described in this guide.

Enabling Sound After Installing Windows 98 

If sound was disabled during the Windows 98 installation, it can be enabled after the operating
system has been installed. To set up the virtual machine to play sound, see the tech note on
VMware Express and sound in this guide. 

Enabling Networking After Installing Windows 98 

If networking was disabled during the Windows 98 installation, it can be enabled after the 
operating system has been installed. To set up networking for a virtual machine, follow the
instructions below. 

1. Shut down Windows 98 and power off the virtual machine. 

2. From the main program window, select Configuration Editor from the Settings menu and 
open the Ethernet Adapters panel. 

3. Select a network connection type for the virtual machine and click the Install button. 

4. Save the updated configuration and power on the virtual machine. 

5. When Windows 98 reboots, it will automatically detect an AMD PCNET Family Ethernet 
Adapter (PCI-ISA) and prompt for the Windows 98 CD-ROM to install drivers. The default 
Ethernet adapter settings should work fine and do not need to be changed. 
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6. Use the Network icon in the Control Panel to view or change network settings. For example, 
you may want to add the TCP/IP protocol since Windows 98 does not install it by default. 

Known Issues 

1. After Windows 98 has been installed, you may notice COM5 and COM6 devices exist within 
the Windows Device Manager. These devices do not actually exist and are not consuming IRQ 
or other resources. You may remove them using the Windows device manager if you like. 

2. Support for EMM386.EXE and other memory managers is currently limited. If you initially 
boot using a customized non-standard MS-DOS or Windows 98 boot diskette, be sure that 
EMM386.EXE (or other memory managers) are not being loaded. HIMEM.SYS and 
RAMDRIVE.SYS can be loaded and used without problems.

Windows 95 Installation Guidelines and Known Problems 

Windows 95 can be installed in a virtual machine using a standard Windows 95 boot diskette and 
CD-ROM. 

Note: Some Microsoft Windows 95 OEM disks included with new computers are customized for 
those computers and include device drivers and other utilities specific to the hardware system.
Even if you can install this Windows 95 operating system on your actual computer, you may not be
able to install it within a VMware Express virtual machine. You may need to purchase a new copy
of Windows to install within a virtual machine. 

Note: Some Windows 95 distributions include instructions that do not include the steps to
fdisk and format a C: drive. You must fdisk and format the VMware Express virtual
IDE hard disk drives before running Windows 95 setup. 

The instructions below are for the simplest case of one virtual IDE hard drive and one virtual IDE
CD-ROM drive. If you have configured the virtual machine with more than one IDE hard drive,
you should also fdisk and format these drives before installing Windows 95. If you have
configured the virtual machine with more than one virtual hard drive or one virtual CD-ROM, you
may need to use different device letters than those in the instructions below. 

Before installing the operating system, be sure that you have already created a new virtual
machine and configured it using the VMware Express Configuration Wizard.

While you are installing the guest operating system, you can click anywhere inside the VMware
Express window to give the virtual machine control of your mouse and keyboard. If you want the
virtual machine to release the mouse and keyboard so you can access your Linux desktop again,
press Ctrl-Alt-Esc.

Windows 95 Installation Steps 

1. Use the VMware Express Configuration Editor to verify the virtual machine's devices are set 
up as you expect before starting the installation. For example, if you would like the Windows 
95 Setup program to install a sound driver, be sure that sound is enabled in the virtual 
machine's configuration. VMware also recommends that you disable the screen saver on the
host system before starting the installation process. 

2. Insert the Windows 95 CD-ROM Setup Boot Disk in floppy drive A: and insert the Windows 
95 CD in the CD-ROM drive. 

3. Power on the virtual machine. 
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4. After the virtual machine boots, if you are presented with a choice of CD-ROM drivers, 
select  the first IDE driver option available (even if your computer has a SCSI CD-ROM 
drive). 

5. Partition the virtual disk. Type: 
FDISK
and answer the questions. 

Note: If you create a primary partition that is smaller than the size of the hard disk, be sure 
the partition is marked Active. 

6. Reboot Windows 95. If the cursor is not already within the VMware Express window, click 
in the window, then press Ctrl-Alt-Del. If prompted on reboot to select a CD-ROM driver, 
select the first IDE CD-ROM driver from the list. 

7. Format the C: drive with
FORMAT C: /S

8. Now start the Windows 95 installation. Type
D:\WIN95\SETUP /IS

Note: An intermittent problem can occur during Windows 95 installations in a virtual 
machine. Shortly after the Windows 95 setup program is started, scandisk runs to 
completion, and when the Windows 95 setup program should start its graphical user 
interface, the virtual machine returns to an MS-DOS prompt. VMware recommends you 
reboot the computer and rerun Windows 95 setup. You will not need to fdisk or format the
drive again. 

9. If the virtual machine's Ethernet adapter is enabled, you will have to add an Ethernet driver 
manually because Windows 95 will not detect it during the Analyzing Computer phase (even
if you selected the network adapter detection option). Do the following to enable 
networking: 

a. Continue with the Windows 95 installation, until you get to the screen titled Windows
95 Setup Wizard/Setup Options. Change the default setting from Typical to Custom 
and click Next to continue. 

b. From the screen titled Network Configuration (which appears after the Analyzing 
Computer phase), click Add, select the Adapter component, select Advanced Micro 
Devices from the manufacturer window and AMD PCNET Family Ethernet Adapter 
(PCI&ISA) from the network adapter window. 

c. If you need TCP/IP networking, add it from the Network Configuration screen 
(Windows 95 Setup does not enable TCP/IP by default). 
If you don't do this, the first phase of the Windows 95 installation will not copy some 
of the files it will need later, and the entire installation will fail. 

10. Finish the Windows 95 installation. 

11. VMware Express virtual disks support DMA transfers for better performance. The feature 
can be enabled after Windows 95 has been successfully installed. To enable the feature, 
right-click My Computer and select Properties. From the System Properties dialog box, click 
the Device Manager tab, double-click the Disk Drives device category, double-click the 
GENERIC IDE DISK TYPE01 device, click the Settings tab and enable the DMA check box. 

Installing VMware Tools

After Windows has been installed, skip ahead to install the VMware Tools, as described in this guide.
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Enabling Sound After Installing Windows 95

If sound was disabled during the Windows 95 installation, it can be enabled after the operating 
system has been installed. To set up the virtual machine to play sound, see the tech note on
VMware Express and sound in this guide. 

Enabling Networking After Installing Windows 95 

If networking was disabled in VMware Express at the time you installed Windows 95, it can be 
enabled after the operating system has been installed. To set up networking for a virtual machine,
follow the instructions below. 

1. Shut down Windows 95 and power off the virtual machine. 

2. From the main VMware Express window, select Configuration Editor from the Settings menu 
and open the Ethernet Adapters panel. 

3. Select a network Connection Type for the virtual machine and click the Install button. 

4. Save the updated configuration and power on the virtual machine. 

5. When Windows 95 reboots, it will automatically detect an AMD PCNET Family Ethernet 
Adapter (PCI&ISA) and prompt for the Windows 95 CD-ROM to install drivers. The default 
Ethernet adapter settings should work fine and do not need to be changed. 

6. Double-click the Network icon in the Control Panel to view or change network settings. For 
example, you may want to add the TCP/IP protocol since Windows 95 does not install it by 
default. 

INSTALL THE VMWARE TOOLS IN YOUR GUEST OPERATING SYSTEM

It is very important that you install VMware Tools in the guest operating system. Although VMware
Express will run a guest operating system without VMware Tools, the graphics environment within
the virtual machine will be limited to VGA mode graphics (640x480, 16 color). 

With the VMware Tools SVGA driver installed, VMware Express supports up to 32-bit displays and
high display resolution, with significantly faster overall graphics performance. Other tools in the
package make it more convenient to use your virtual machine. 

Installation files for VMware Tools for Windows are built into VMware Express (Settings >
VMware Tools Install). VMware Tools for Windows supports Windows 95 and Windows 98
guest operating systems. 

Install VMware Tools for Windows 98 and Windows 95

1. Power on the virtual machine. The following steps all take place inside the virtual machine, 
not on the host computer.

2. Prepare your virtual machine to install the VMware Tools. This will reconfigure the first
floppy drive in your virtual machine.
Choose Settings > VMware Tools Install. 

If you decide not to proceed with the installation of VMware Tools, you may cancel the 
operation.
Choose Settings > Cancel VMware Tools Install.

3. Double-click the My Computer icon on your desktop. 
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4. Double-click the A: drive icon. 

5. Double-click VMwareTools.exe and follow the instructions.

Instructions for configuring the video driver will open automatically in Notepad at the end of 
the installation process. If the Notepad window is hidden, bring it to the front by clicking the 
Notepad button on the Windows taskbar. 

Configuring the Video Driver on Windows 98

The detailed steps that follow are for a Windows 98 guest operating system. See the next section 
for details on the Windows 95 installation. 

1. When you click the Finish button after installing VMware Tools, the Display Settings window 
opens. 

2. Click the Advanced button. A dialog entitled Standard Display Adapter (VGA) Properties 
appears. 

3. Click the Adapter tab. 

4. Click the Change button. This will start the Update Device Driver Wizard. Click Next. 

5. The Wizard presents you with two options. Choose the option to "Display a list of all drivers 
in a specific location..." Click Next. 

6. Click the Have Disk button. This brings up the Install From Disk dialog. 

7. Enter the following path, and click OK:
A:\win9x 

8. Select VMware SVGA(FIFO) display adapter and click OK. 

9. Answer Yes to the on-screen question, then click Next to install the driver. After the driver is 
installed, click Finish. 

10. Click Close from the SVGA Properties dialog, then click Close from the Display Setting 
dialog. 

11. The VMware Tools background application will be launched automatically when you reboot
your virtual machine. 
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12. After restarting the Windows 98 virtual machine, open the device manager and verify that 
the display adapter is VMware SVGA(FIFO). 

13. You should notice the presence of a Standard PCI Graphics Adapter too. 

Configuring the Video Driver on Windows 95

The detailed steps that follow are for a Windows 95 guest operating system. See the previous 
section for details on the Windows 98 installation. 

1. When you click the Finish button after installing VMware Tools, the Display Settings 
window opens. 

2. Click the Advanced Properties button. The Advanced Display Properties dialog will appear.

3. Click the Change button. This will bring up the Select Device dialog. 

4. Click the Have Disk button. The Install From Disk dialog will appear.

5. Enter the following path:
A:\win9x

6. Click OK to install the driver.

7. Click Close from the Advanced Display Properties dialog, then click Close from the Display 
Setting dialog.

8. Click Yes to restart Windows 95 and start using the new video driver.
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9. After restarting the Windows 95 virtual machine, open the device manager and verify that 
the display adapter is VMware SVGA(FIFO).

10. You should notice the presence of a Standard PCI Graphics Adapter too.

Configuring VMware Tools for Windows 98 and Windows 95 

1. Right-click the VMware Tools icon in the system tray, then click Main window.... 
(Or double-click the VMware Tools icon in the system tray.) 
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2. The VMware Toolbox cursor options are: 
• Release input focus when the mouse leaves the virtual machine 
• Capture input focus when the mouse enters the virtual machine 
• Scroll when mouse nears edge of the virtual machine 
• Hide Cursor when the virtual machine loses input focus 
• Bring the virtual machine to top when it gets input focus 

The VMware Tools Miscellaneous Options are: 
• Allow copy and paste to and from the virtual machine 
• Time synchronization between the virtual machine and the host operating system

3. The Devices tab of the VMware Toolbox options allows you to enable or disable removable 
devices. (You can also set these options by right-clicking the VMware Tools icon in the 
system tray, then clicking Devices, or navigate to them from the Devices menu of the VMware
Express application.) 
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4. The Shrink tab gives you access to the settings you need if you wish to reclaim unused space 
in a virtual disk. 



Running VMware Express

2
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Running VMware Express

Now that you have installed a guest operating system and the VMware Tools, how do you run your
virtual machine? This section gives you the highlights of the most common tasks. 

For purposes of illustration, this guide assumes Windows 98 is the guest operating system. Some
commands used in the illustrations may be different for Windows 95. 

Think of your VMware Express virtual machine as a separate computer that runs in a window on
your computer's desktop. 

Instead of using physical buttons to turn this computer on and off, you use buttons at the top of
the VMware Express window. 

When virtual machine is powered off 

When virtual machine is powered on

The power button will be labeled Power On or Power Off, depending on whether your virtual
computer is running or not. 
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Starting a Virtual Machine 
1. Open a terminal, type vmware and press Enter. 

2. Select the "Open an existing configuration" radio button, then click OK. 
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3. Browse to your virtual machine's directory. Highlight the win98.cfg file, then click OK. 

4. Click the Power On button to start the virtual machine. 

5. Click anywhere inside the VMware Express window to give the virtual machine control of 
your mouse and keyboard. 

If you want the virtual machine to release the mouse and keyboard, press Ctrl-Alt-Esc.

6. If you need to log on to a network, type in your name and password just as you would on a 
regular computer. 
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Using a Virtual Machine 

When VMware Tools for Windows 98 and Windows 95 are running, the VMware Tools icon appears in the system tray

Using the Full Screen 

If you want your VMware Express virtual machine's display to fill the screen – so you no longer 
see the borders of the VMware Express window – click the Full Screen button on the tool bar. 
To get out of full-screen mode – to show your virtual machine inside a VMware Express window
again – press the Ctrl-Alt-Esc keys at the same time. 

If you are using the Enlightenment window manager on your host, VMware also recommends that 
you disable the screen saver on the host system before going into full screen mode. 

Installing New Software Inside the Virtual Machine 

Installing new software in a VMware Express virtual machine is just like installing it on a regular 
computer. 

1. Be sure you have started the virtual machine and, if necessary, logged on. Check the Devices
tab in VMware Tools to be sure the virtual machine has access to the CD-ROM and floppy 
drives. 

2. Insert the installation CD-ROM or floppy disk into the proper drive. If you are installing from
a CD-ROM, the installation program may start automatically. 

3. If the installation program does not start automatically, click the Windows Start button, go to
Settings > Control Panel, then double-click Add/Remove Programs and click the Install 
button. Follow the instructions on screen and in the user manual for your new software. 



2-5
www.vmware.com

Installing and Configuring VMware

Cutting and pasting 

Be sure you have installed and started the VMware Tools in your virtual machine. 

In Windows, you will see a VMware Tools icon in the system tray when the VMware Tools are
running. When the VMware Tools are running, you can copy and paste between applications in
the virtual machine and the host computer. 

Disconnecting and reconnecting removable devices

Sometimes you may need to disconnect a removable device from your virtual machine. For 
example, you may need to let your host computer use the floppy disk drive or the CD-ROM drive.

While your virtual machine is running, you may use the Devices menu to disconnect and recon-
nect removable devices. 

To change the default settings – whether the device is connected when you first start your virtual 
machine – use the Configuration Editor (Settings > Configuration Editor) when the virtual
machine is powered off.
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Shutting Down a Virtual Machine 
1. Select Shut Down from the Start menu of the guest operating system (inside the virtual 

machine). 

2. Select the Shut Down radio button, then click OK. 

3. After the guest operating system shuts down, it is safe to power off the virtual machine and 
exit the VMware Express application. Click the Power Off button, then select File > Exit. 
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CONFIGURATION WIZARD

Starting the Configuration Wizard

When VMware Express is started, the startup screen has three options: Run the Configuration 
Wizard, run the Configuration Editor, or open an existing configuration. The default selection is
the Configuration Wizard: clicking the OK button starts the Configuration Wizard. The
Configuration Wizard can also be started from the File menu (select File > Wizard). 

Running the Configuration Wizard

The Configuration Wizard will present you with a series of screens that are navigated using the 
Next and Prev buttons at the bottom. At each screen, follow the instructions, then click the Next
button to proceed to the next screen. Each screen will ask you a question. You will either have to
select an option or fill in some information. 

There is also a Finish button, which is initially dimmed. When there is enough information for the
Configuration Wizard to finish the configuration, this button displays. Click the Finish button to
have the Configuration Wizard fill in all of the remaining options with default values. Clicking
Finish is the fastest way of configuring your virtual machine. 

Clicking the Help button will open a pop-up window with context-sensitive help. 

Your Virtual Machine Directory

VMware Express stores your virtual disk file and other files associated with your virtual machine 
together in one directory. Each virtual machine should have its own directory. The default location
is the directory ~UserHome/vmware/VM or /home/UserHome/vmware/VM where UserHome is the
currently logged in user's name. 

If you have set up more than one virtual machine, the files for each will be stored in the directory 
you specified for it in the Configuration Wizard.

Virtual machine performance may suffer if your virtual hard disk is on an NFS mounted file 
system. You should be sure that the virtual machine's directory is on a local file system. 

Selecting the Size of the Virtual Disk (for new virtual disks)

Fill in the size of the virtual disk that you wish to create. The size should be large enough to hold
the guest operating system and all of the software that you intend to install in the virtual machine,
with room for data and growth. There is no way to increase this number later, although you can
install additional virtual disks if you run out of space on this one. 

The file that holds the virtual disk is not created at the maximum size of the virtual disk, but at a 
smaller size. This file grows as the virtual machine writes to the virtual disk. 

Enabling the CD-ROM Drive 

Select whether or not to allow the virtual machine to access the CD-ROM drive. If you wish to 
allow the virtual machine to access the CD-ROM device, the path to that device must be specified.
This path is set to /dev/cdrom by default. 

Note that most operating systems will require the use of a CD-ROM during installation. 

Even if the virtual machine has CD-ROM access enabled, access to the CD-ROM device can be 
disabled during the operation of the virtual machine using the Devices menu. 
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Enabling the Floppy Disk Drive 

Select whether or not to allow the virtual machine to access the floppy disk drive. If you wish
to allow the virtual machine to access the floppy disk device, the path to that device must be 
specified. This path is set to /dev/fd0 by default. 

Note that some operating systems may require the use of a floppy drive during installation. 

Even if the virtual machine has floppy disk access enabled, access to the floppy disk device can 
be disabled during the operation of the virtual machine using the Devices menu. 

Configuring the Networking Capabilities of the Virtual Machine 

The virtual machine can be configured to operate in a stand-alone mode, or it can be 
networked to the host machine, or it can be bridged to the real network (assuming the host is 
on a network). This screen lets you select the option that applies to this virtual machine. 

The No Networking option configures the virtual machine to be a stand-alone machine. In this 
case, the virtual machine has no networking support, like a PC with no network card. 

The Bridged Networking option configures the virtual machine to have a network adapter, and 
this network adapter is connected to the host network card through a bridge. The bridge 
forwards packets from the host's network interface to the virtual machine and forwards packets
from the virtual machine to the network interface of the host. This allows the virtual machine to
appear like a real machine to other machines on the network. If this option is selected, the virtual
machine needs to be assigned an IP address, just like a real machine. DHCP can be used to do
this automatically. 

The Host-only Networking option configures the virtual machine to have a network, but the virtual
machine is visible only to the host machine on which the virtual machine is running, and not to
other machines on the network. This is useful for sharing files between the virtual machine and
the host machine. 

The tech note titled Networking provides more details about VMware Express networking options. 

Congratulations

This screen displays the configuration settings that you have selected, or that have been selected
for you by default. If you want to change any of these settings, the Prev button will take you to the
earlier screens, where you can make your changes. 

Clicking the Done button saves the configuration and returns you to the main program window. 
To start the virtual machine you just configured, click the Power On button. 

The configuration settings can be viewed and modified using the Configuration Editor, in the 
Settings menu (Settings > Configuration Editor).

Note: Before you can run your new virtual machine, you must install a guest operating system. 
This guide includes instructions for installing Windows 98 and Windows 95 as guest operating
systems. If you start up a new virtual machine that has no guest operating system installed and
you do not have a bootable CD-ROM or floppy disk in the virtual machine, it will display an error
message that says, "Operating System not Found." 

CONFIGURATION EDITOR

A virtual machine configuration is kept in a text file. VMware recommends that you create this file
using the Configuration Wizard. You can modify configuration settings using the Configuration
Editor. 
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1. Launch the VMware Express program.
vmware

2. Select Open an Existing Configuration, click OK, then browse to your virtual machine's 
configuration file and open it.

3. Open the Configuration Editor (Settings > Configuration Editor).

4. Make any changes you want to, as described in this section, then click Save to save the 
configuration and close the Configuration Editor.

• One IDE drive (P-M) is created by default. To create another disk drive, follow these steps.

1. Click the + next to IDE Drives. 

2. Click the name of a drive that is shown as Not Installed. 

3. Choose Device Type. 

4. Enter the name of the disk to be created in the File Name field (the disk image will 
be saved in a file in the directory from which you are running).

Enter the disk size (or use the default).

Note: The specified size is the maximum disk capacity. The space taken by the file 
will usually be less, particularly before anything is placed on the disk. 

5. Click Create. 

6. Click Install.

Note: You may also use this section of the Configuration Editor to modify the settings 
for a disk that is already configured in your virtual machine.

• One IDE CD-ROM drive (S-M) is created by default. To create another CD-ROM drive, follow 
these steps.

1. Click the + next to IDE Drives. 

2. Click the name of a drive that is shown as Not Installed. 

3. Choose Device Type CD-ROM. 

4. Enter /dev/cdrom or the path to the CD-ROM in the Name field. 

5. Click Install. 

Note: You may also use this section of the Configuration Editor to modify the settings 
for a CD-ROM drive that is already configured in your virtual machine.

• One floppy drive (A:) is installed by default, using /dev/fd0. To change the path or add 
another floppy, follow these steps. 

1. Click the + next to Floppy Drives. 

2. Click Not Installed to add a drive or click the entry for the device you want to modify. 

3. Enter /dev/fd1 or the path to your floppy device. 

4. Click Install. 

• Add a virtual machine network adapter. 

1. Click the + next to Ethernet Adapters. 

2. Click Not Installed. 
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3. Leave the Connection Type as Bridged.
(If you are not connected to a network with an Ethernet card, use the Host-only 
option or choose not to configure the Ethernet adapter.) 

4. Click Install.

Note: You may also use this section of the Configuration Editor to modify the settings 
for a network adapter that is already configured in your virtual machine. The tech note 
titled Networking provides more details about the networking options.

• Add or modify a serial port. 

1. Click the + next to Serial Ports. 

2. Click an entry that shows Not Installed to add a port or click the entry for the port 
you want to modify. 

3. Specify the path your host machine is using to the device.

Note: This is not the place to configure a serial mouse. You can find those settings 
under the Mouse item.

• Add or modify a parallel port. 

1. Click the + next to Parallel Ports. 

2. Click an entry that shows Not Installed to add a port or click the entry for the port 
you want to modify. 

3. Specify the path your host machine is using to the device.

• Change mouse to a serial mouse (or other).

Click Autodetect and change the setting to the mouse you have. 

• Change default memory settings (32MB).

Use the slider. 

• Configure the miscellaneous options.

You can use the Misc. section of the Configuration Editor to set other parameters for your 
virtual machine. 

Require SHIFT in hot key sequences

Select this box to change hot key combinations from CTL-ALT-key to CTL-ALT-SHIFT-key. This is 
useful if you want to prevent certain key combinations (for instance, CTL-ALT-DEL) from being
intercepted by VMware Express instead of being sent to the guest operating system. 

Power on when program starts

Select this box if you want the virtual machine to automatically power on when VMware Express 
is launched. If you choose this option, you will not have an opportunity to modify configuration
options prior to booting the virtual machine. 

Switch to full screen at every power on

Select this box if you want the virtual machine to switch immediately to full screen mode when the 
virtual machine is powered on. The virtual machine will enter full screen mode when you click
the Power On button or if you have selected the option to power on when the program starts. 
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Exit at power off

Select this box if you want to automatically close the VMware Express application when you power 
off the virtual machine or suspend it to disk. When this option is selected, power off is equivalent
to clicking Power Off then File > Exit. 

Find best resolution in full screen mode

This option is selected by default. When selected, VMware Express will choose the best resolution 
for your virtual machine when it enters full screen mode. If you do not want VMware Express to
find the best resolution for your virtual machine screen, unselect this option. 

Logging level

VMware Express always logs important events in a log file, so that if the program crashes, or 
some other critical event occurs, information is available to help VMware technical support
understand the problem, find workarounds, and fix it in a later product release. Log files are
normally written to the directory that contains the virtual machine configuration file.

In many cases, however, the logged information is not sufficient. An error message may ask you 
to run with the logging level set to Debug and try to repeat the problem. This enables additional
logging that can make it easier, or possible, to fix the problem. 

Enabling debugging information makes the log file grow faster and also turns on a large number 
of internal consistency checks that can slow down execution. For this reason, unless you are 
trying to reproduce a problem, it is best to run with the level set to Normal. 

USING VMWARE TOOLS TO SHRINK A VIRTUAL DISK

You can physically reclaim space in virtual disks using the shrink functionality provided in the
VMware Tools for Windows. This operation requires free disk space equal to the size of the virtual
disk being shrunk. 

To shrink partitions of a virtual disk: 

1. Maximize the VMware Tools 

2. Select the Shrink tab 

3. Consult the VMware Tools Help > Shrink help... for detailed information on shrinking 
virtual disks 

MEMORY USAGE

VMware Express allows users to set the memory size of each virtual machine and the amount of
physical host memory reserved for virtual machines. By adjusting the memory size of the virtual
machine, users can affect both virtual machine and overall system performance. In this note we
describe how VMware Express uses the memory configuration parameters to properly manage
virtual machines and reserved memory. 

Virtual Machine Memory Size

You can set the size of the virtual machine's physical memory via the Configuration Edit or 
(Settings > Configuration Editor > Memory). The minimum size of the memory for the virtual
machine should be set based on the recommendations of the operating system provider. 
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The Configuration Wizard sets what we believe are reasonable defaults for the memory size of a 
virtual machine based on the type of the guest operating system. The actual size that should be
given to a virtual machine depends on a few parameters. 

• What kinds of applications are to be run in the virtual machine 
• What applications are going to be running on the host at the same time as the virtual machine

Linux does not behave well when it runs low on free memory. For this reason users should not 
run virtual machines whose memory requirements exceed that of the host and other applications.
To help guard against virtual machines causing the host to thrash, VMware Express enforces a
limit on the total amount of memory that may be consumed by a virtual machine. The memory
used by the currently running virtual machine cannot exceed the amount of physical memory on
the host minus some memory that must be kept available for the host. 

Some memory must be kept available on the host to ensure the host will be able to operate 
properly while a virtual machine is running. The amount of memory reserved for the host
depends on the host and the size of the host's memory. 

NETWORKING

Overview 

Each virtual machine can have its own independent network configuration. There are three 
choices for configuring networking: 

• No networking 
• Host-only networking 
• Bridged networking 

No networking simply means a virtual machine is run in isolation; it will not be able to 
communicate with the host operating system or any other virtual machine running on the host.
This option is useful if you desire complete isolation for testing or security purposes. To set up
your virtual machine in this way, simply do not install a network interface adapter when 
configuring the virtual machine. 

If you have set up a virtual machine with networking and decide you want to remove it, use the
Configuration Editor (Settings > Configuration Editor), click the + sign beside Ethernet Adapters,
select the adapter you wish to remove, then click Remove. Click Save to save the changes and
close the Configuration Editor.

Host-only networking means a virtual machine can communicate with the host operating 
system and any other virtual machines set up to use host-only networking, but the virtual machine
cannot communicate with any systems off the host machine without the use of a proxy server. 

If you chose to install Samba when you installed VMware Express – or if you already had Samba 
configured appropriately on your host – the guest operating system can share files with the host
using the facilities of the host-only network.

Host-only networking is most useful when the host is itself isolated or when you want to isolate 
your virtual machines from systems outside the host computer. This configuration is analogous to
the way corporations often connect their internal networks to the Internet with a firewall and
proxy services. To set up a virtual machine in this way you need to install a network interface
adapter and mark it as "hostOnly." Once the guest operating system is installed you may then need
to do some additional configuration that is described below. 
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Bridged networking means a virtual machine runs on a virtual network that is "bridged" to an 
existing physical network. This permits a virtual machine to appear as a full-fledged host on an
existing physical network. 

A bridged virtual machine may transparently use any of the services available on the network that 
it is bridged to: printers, file servers, gateways, etc. Likewise, when a virtual machine is bridged,
any physical host – or other virtual machine configured as bridged – can use resources on that
virtual machine. This is the most commonly used networking configuration. To manually 
configure bridged networking you need to install a network interface adapter and mark it as
"bridged." Once the guest operating system is installed, you may then need to do some additional
configuration work that is described below. 

What You Will See on the Host

VMware Express networking support is done on the host machine through a virtual network 
device driver that implements two network interfaces: vmnet0 and vmnet1. Each interface is 
associated with a virtual Ethernet hub through which any number of virtual machines and the 
host may communicate. By convention vmnet0 is used for bridged networking and vmnet1 is 
used for host-only networking. In addition to the network interfaces there are two applications: 
vmnet-bridge and vmnet-dhcpd. The vmnet-bridge application is used by the bridged networking
support to effect transparent communication between vmnet0 and another network interface, 
typically eth0. vmnet-dhcpd is an optional process that runs only when host-only networking is
configured; it implements the DHCP protocol for virtual machines running on vmnet1. 

What You Will See on the Guest Operating System

Network support on the guest operating system appears through the virtual Ethernet adapter(s) 
that are configured for the virtual machine. Each device appears to the operating system as an
AMD PCNET PCI adapter. Most operating systems will recognize this virtual hardware and auto-
matically configure use of the appropriate device driver. The main issue in completing network
configuration in the guest operating system is assigning a network address for the virtual machine.

More Details about Host-Only Networking

Setting Up Host-Only Networking On The Guest Operating System

Host-only networking means a virtual machine can communicate with the host operating system 
and any other virtual machines set up to use host-only networking, but the virtual machine cannot
communicate with any systems off the host machine without the use of a proxy server. This is
done by creating a private virtual network that the host and all host-only configured virtual
machines reside on. Typically all the parties on this private network use the TCP/IP protocol suite,
although there is no requirement for this. 

Regardless of the communication protocols used, each virtual machine and the host must be 
assigned addresses on the private network. This can be done "statically" (that is, by consulting a
fixed database) or "dynamically" using protocols such as the Dynamic Host Configuration
Protocol (DHCP). When host-only networking is enabled at the time VMware Express is installed,
a custom DHCP server application is set up to run on the host machine. This server implements
the DHCP protocol only for virtual machines running on the host-only network associated with the
virtual network interface vmnet1. Guest operating systems that are set up to use DHCP at boot
time to obtain an IP address will then work without any additional configuration (except for 
setting up names, as described below). Guest operating systems that do not use DHCP to obtain
an IP address must be set up with a static IP address. 
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Selecting IP Addresses For Virtual Machines On A Host-Only Network

You have two choices for setting up IP addresses for virtual machines on a host-only network: 
dynamic assignment using DHCP or static assignment. Using DHCP to assign IP addresses is 
simpler and more automatic than statically assigning them. Most Windows operating systems, for
example, come preconfigured to use DHCP at boot time so they will be functional the first time
they are booted, without additional configuration. If, however, you want your virtual machines to
communicate using names instead of IP addresses, then you need to set up a naming convention,
a name server on the host machine, or both. In this case it may be simpler just to use static IP
addresses. 

VMware recommends that if you have virtual machines you intend to use frequently or for 
extended periods of time, you assign them static IP addresses or configure the host-only DHCP
server to always assign the same IP address to the virtual machine. For virtual machines that you
do not expect to keep for long, use DHCP and let it allocate an IP address. 

Note that for each host-only network, the available IP addresses are split up using the following 
conventions. (VMware Express always uses a Class C address for host-only networks.)

Range Address Use Example 

<net>.1 host machine 192.168.0.1 

<net>.2-<net>.127 static addresses 192.168.0.1-192.168.0.127 

<net>.128-<net>.254 DHCP-assigned 192.168.0.128-192.169.0.254 

<net>.255 broadcasting 192.168.0.255 
(where <net> is the network number assigned to your host-only network.) 

Avoiding IP Packet Leakage in a Host-Only Network

Each host-only network is intended to be confined to the host machine on which it is set up. That
is, no packets sent by virtual machines on this network should "leak out" to a physical network
attached to the host. Packet-leakage can only occur if a machine actively forwards packets. Note
that this can be true of the host machine or any virtual machine running on the host-only network.

Systems that support the TCP/IP protocols are usually capable of forwarding IP packets they 
receive but which are not addressed to them. By default, however, these systems come with IP
packet forwarding disabled. If you find packets leaking out of a host-only network, check if 
forwarding has mistakenly been enabled on the host machine, and if it is enabled, disable it. 
For Linux systems this is done by writing a 0 to the special file /proc/sys/net/ipv4/ip_forward. 
For example, type the following command:
echo 0>/proc/sys/net/ipv4/ip_forward
(note that this must be done as the super-user). For other systems there is a system configuration
option that can be set through a control panel, at compile time, or possibly at boot time. Consult
your system documentation. 

If the host has multiple network adapters, then it is likely intentionally configured to do IP 
forwarding and you do not want to disable it. In this case the only way to avoid packet-leakage is
to enable a "packet filtering" facility and specify that packets from the host-only network should
not be sent off-machine. An explanation of how to do this is beyond the scope of this document;
consult your system documentation. 

Finally, be aware that virtual machines may leak packets as well. For example, if you use Dial-Up 
Networking support on a virtual machine, then if packet forwarding is enabled, host-only network
traffic may leak out through the dial-up connection. 
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Controlling Routing Information for a Host-Only Network

A host-only network is a full-fledged network. It has a network interface associated with it 
(vmnet1) that is marked "up" at the time the host operating system is booted. 

Consequently, routing server processes that operate on the host operating system, such as routed 
and gated, will automatically discover it and propagate information on how to reach it unless you
explicitly configure them not to. If either of these programs is being run only to receive routing
information, then the easiest solution is to run them with a -q option so that they do not supply
routing information, only receive it. If, however, they are running because they are to supply 
routing information, then you need to configure them so they do not advertise routes to the 
host-only network. 

Unfortunately, the version of routed that comes with many distributions of Linux has no support
for specifying that an interface should not be advertised. Consult the routed(8) manual page for
your system in case you have a more contemporary version of the software. 

For gated, configuration is involved. You need to explicitly exclude the vmnet1 interface from any
protocol activity.

Using Samba for File Sharing on a Host-Only Network

VMware Express for Linux can automatically install and configure a Samba server to act as a file 
server for Microsoft Windows 95 and Windows 98 guest operating systems.

For details, read the tech note Using Samba for File Sharing.

Other Potential Issues with Host-Only Networking

The following are common questions and issues that may arise when configuring a host-only 
network. 

Q: DHCP on the host machine does not work after I install VMware Express.

A: If you were running the DHCP server program dhcpd on your machine before installing 
VMware Express, then it probably was configured to respond to DHCP requests from clients on
any network interface present on the machine. When host-only networking is configured, an 
additional network interface, vmnet1, is marked "up" and available for use, and dhcpd may
notice this. In this case some dhcpd implementations abort if their configuration files do not
include a "subnet" specification for the interface – even if dhcpd is not to respond to messages
that arrive through the interface. The best solution to this problem is to add a line to the dhcpd
configuration file of the form:
subnet <net>.0 netmask 255.255.255.0 {}
(where <net> is the network number assigned to your host-only network; for example, 
192.168.0). This informs dhcpd about the host-only network and tells it explicitly not to respond
to any DHCP requests it sees coming from it. 

An alternative solution is to explicitly state the set of network interfaces that you want dhcpd to 
listen to each time you start the program. For example if your machine has one Ethernet interface
eth0, then each time you start dhcpd you would list it on the command line:
dhcpd eth0
rather than have it probe for all available network interfaces. 

If the above solutions do not work for your dhcp server program, then it likely is old. You can try 
upgrading to a more current version such the Version 2 DHCP software available from the ISC
(see http://www.isc.org). 

Technical Reference Notes
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Q: Is there any way to use DHCP and Dynamic Domain Name Service (DDNS) on a
host-only network?

A: DHCP can be used to hand out IP addresses as well as other information, such as the identity 
of a host running a name server and the nearest router/gateway. But it does not currently provide
a means to dynamically establish a relationship between the IP address it assigns and a client's
name (that is, to update a DNS server using DDNS). This facility is scheduled to be part of the
Version 3 DHCP server available from the Internet Software Consortium (ISC). When that is 
available we will update our software to use that server. 

In the meantime, if you want to use names to communicate with other virtual machines you will 
need to either edit the DHCP configuration file for vmnet1 (/etc/vmware/vmnet1.conf) or use IP
addresses that are statically bound to a host name. Editing the DHCP server configuration file
requires information that is best obtained directly from the DHCP server documentation; consult
the UNIX manual pages dhcpd(8) and dhcpd.conf(8). 

More Details about Bridged Networking 

Setting Up Bridged Networking On The Guest Operating System

Bridged networking means a virtual machine appears just like any other host on the physical 
network. You need to configure operating system support for the virtual Ethernet adapter, then
either assign a fixed network address or enable use of DHCP for dynamic address assignment.

Assigning a network address is done according to local conventions – if your site runs DHCP, then 
you may choose to enable DHCP use, otherwise you will need to consult a network administrator
to obtain a network address. Be aware that if the host machine is set up to boot multiple 
operating systems and you run one or more of them in virtual machines, then you will need to
configure each operating system with a unique network address. (Many people assign all systems
the same address since they assume only one will be running at a time!) 

Changing the MAC Address of a Virtual Machine

When a virtual machine is powered on, VMware Express automatically assigns it a MAC address.
The software guarantees that virtual machines will be assigned unique MAC addresses within a
given host system. However, the software does not guarantee that a given virtual machine will be
assigned the same MAC address every time it is powered on. In addition, VMware Express does its
best, but cannot guarantee, to automatically assign unique MAC addresses for virtual machines
running across multiple host systems. 

If you want to guarantee that the same MAC address is assigned to a given virtual machine every 
time, or want to guarantee a unique MAC address for each virtual machine within a networked
environment, you can assign it manually instead of allowing VMware Express to assign it 
automatically. It is possible to manually assign the same, unique MAC address to any virtual
machine by adding the following line to its configuration file:
ethernet0.address = 00:50:56:XX:YY:ZZ
where XX is a valid hex number between 00h and 3Fh, and YY and ZZ are valid hex numbers 
between 00h and FFh. VMware Express virtual machines do not support arbitrary MAC addresses,
hence the above format must be used. 

Note: As long as you choose XX:YY:ZZ so it is unique among your hard-coded addresses
(where XX is a valid hex number between 00h and 3Fh, and YY and ZZ are valid hex numbers
between 00h and FFh), conflicts between the automatically assigned MAC addresses and the man-
ually assigned ones should never occur.

Technical Reference Notes
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USING SAMBA FOR FILE SHARING

VMware Express includes a Samba server that is automatically configured to act as a file server
for Microsoft Windows 95 and Windows 98 guest operating systems. You can simply drag and
drop their files between different environments without needing to manually configure Samba on
your system. 

The lightly modified Samba server installed by VMware Express runs over the VMware Express
virtual Ethernet, and the Samba traffic between different operating systems is isolated from actual
local area networks. 

The source code diffs for the changes, based on Samba 2.0.6, are available from the VMware Web
site. A download link is at http://www.vmware.com/support/reference/linux/samba_2_linux.html.

VMware hopes these changes will be integrated in the next release of Samba. 

Adding User Names and Passwords to the VMware Samba Password File

You may add user names and passwords to the VMware Samba password file at any time from a 
terminal window on your Linux host computer.

1. Log in to the root account.
su

2. Run the VMware Samba password command. 
vmware-smbpasswd vmnet1 -a <username>
where <username> is the user name you want to add.

Follow the instructions on the screen.

Note: vmware-smbpasswd is based on the standard Samba password program. If you 
are familiar with the options used in smbpasswd, you may use any of them in vmware-
smbpasswd.

3. Log out of the root account.
exit

If you receive an error message that says 
Unknown virtual interface "vmnet1" 
this indicates your machine is not using the VMware Samba server.

If your installation of VMware Express does not include the VMware Samba server and you 
want to set it up, log in to the root account on your host computer (su), then 
run vmware-config.pl from a terminal on your host computer. When the configuration
script asks Do you want this script to automatically configure your system to allow your virtual
machines to access the host file system? Answer Yes.
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SOUND

VMware Express provides a virtual audio device compatible with the Creative Technology Sound
Blaster® 16 and supports sound in Windows 95 and Windows 98 guest operating systems. The
VMware Express sound device is disabled by default and must be enabled in the VMware Express
Configuration Editor. Sound support is currently limited to PCM (Pulse Code Modulation) output
(that is, any application that produces sound without using MIDI). 

Configuring Sound with VMware Express 

1. Configure sound on the Linux host operating system. Refer to the documentation for your 
particular Linux. You may need to install additional software packages on your system to 
support sound. VMware cannot provide support assistance in configuring sound on your 
host operating system. Please contact your host operating system support provider or PC 
manufacturer for help. 

2. Enable sound within the virtual machine. The sound virtual device is not installed in the 
virtual machine by default. In the VMware Express Configuration Editor, open the Sound 
Adapter panel and click the Install button. Save the configuration and power on the virtual 
machine. 

3. Configure the guest operating system to use the VMware Express virtual sound device. This 
device is compatible with a Creative Technology Sound Blaster 16. 

4. If you have never installed a Sound Blaster 16 Card in this Windows system previously, you 
will need a Windows 95 or Windows 98 installation CD-ROM. 

a. Launch Add New Hardware from the Windows Control Panel. 

b. Click Next. 

c. Select Yes for "Do you want Windows to search for new hardware?" 

d. Click Next. 

e. Click Next again. 

f. Windows should run the autodetection and say it is ready to finish. 

g. If prompted to do so, insert the Windows CD-ROM into the drive and click OK. 

h. Click Finish. 

5. If you have problems with Windows autodetection, add the device manually. 

a. Launch Add New Hardware from the Windows Control Panel. 

b. Click Next. 

c. Select No for "Do you want Windows to search for new hardware?" 

d. Click Next. 

e. Select "Sound, video and games controllers." 

f. Click Next. 

g. Select "Creative Labs Sound Blaster 16 or AWE-32." 

h. Click Next. 

i. Click Finish. 
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Known VMware Express Sound Limitations 

• Sound support is limited to Sound Blaster compatible PCM (Pulse Code Modulation) output. 
This includes the ability to play .wav, .au and Real Audio formats. 

• MIDI sound is not supported. 

• Game ports/joysticks are not currently supported. 

• Sound does not work well with several games, especially fast, interactive games. 

PARALLEL PORT BEHAVIOR

VMware Express supports two types of virtual parallel port devices: unidirectional ports (SPP)
and a partial emulation of bidirectional PS/2-style ports. Unidirectional ports are supported in all
Linux host versions. Bidirectional ports are supported in Linux kernel versions 2.2.5 or later. 

VMware Express requires that the parallel port "PC-style hardware" option
(CONFIG_PARPORT_PC) be built and loaded as a kernel module (that is, it must be set to "m").
VMware Express is unable to use bidirectional parallel port devices if CONFIG_PARPORT_PC is
built directly (compiled) into the kernel. This limitation exists because CONFIG_PARPORT_PC
does not correctly export its symbols.

Unidirectional Ports

Unidirectional ports are supported for backward compatibility. They are used typically to connect 
to printers or to send the printer output to a file. The speed is usually adequate for printing text,
but expect long delays when printing images. 

The pathnames of the host devices for unidirectional ports are typically /dev/lp0, /dev/lp1, etc. 

Bidirectional Ports

Bidirectional ports are used by a variety of devices (printers, scanners, dongles, disk drives). 

Currently, VMware Express provides only partial emulation of PS/2 hardware. Specifically, 
interrupts requested by a device connected to the physical port are not passed to the virtual
machine. Also, the guest operating system cannot use DMA (direct memory access) to send data
to or from the port. This may be resolved in a future release of VMware Express. 

For this reason, and for the time being, not all devices that attach to the parallel port are 
guaranteed to work correctly. Below is a partial list of devices, which we will update as we gain
further information. If you try out a device that's not in the list, we would like to hear about it. 

Bidirectional emulation is slower than native access but faster than unidirectional emulation, so 
this is the recommended mode, when possible, even when the device is unidirectional (as with
printers). 

The pathnames of the host devices for bidirectional ports are usually /dev/parport0, 
/dev/parport16, /dev/parport32, etc. The VMware Express installer creates these devices if they 
do not exist. They may be also created by hand using mknod. For example, to create the second 
parport (parport16), type the following command:
mknod /dev/parport16 c 99 16 

Default Configuration

Parallel ports by default are bidirectional on Linux hosts 2.2 or later. They are unidirectional 
otherwise. Their default base addresses are, in order, 0x3bc, 0x378 and 0x278. None of the ports
have an assigned IRQ or DMA channel. The ports are not present by default. 
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Installation on Guest Operating Systems

On Windows 9x, when a port is changed from unidirectional to bidirectional or vice versa, it is 
necessary to remove the device driver for that port (double-click the System icon in the Control
Panel) and add a new one. Adding a new driver is also required when a new port is added. In
both cases use the Add New Hardware icon in the Control Panel and let Windows detect the new
device(s). Manually selecting the devices from a list may result in an incorrect configuration. 

Troubleshooting

If an error message is displayed at power on stating the parallel port on the host does not have an
ECR (Extended Control Register), it is possible the hardware supports it but it has been disabled
in the BIOS. In this case, reboot your host, enter the BIOS configuration editor (typically by 
holding down the Delete key during early execution of the BIOS), find the parallel port field, and
enable ECP mode (or other combination of modes that include ECP). Most modern computers
should support ECP mode.

Devices Known to Work

Adobe dongle Windows 95 guest

RIO MP3 player Windows 95 guest

UMAX Astra 1220 P scanner Windows 95 guest

Hewlett-Packard LaserJet 5MP printer Windows 9x guests

Canon Bubble Jet BJ-200e printer Windows 9x guests

Iomega ZIP drive Requires recent drivers (see note below).

Devices That Probably Work

Dongles Most dongles are likely to work.

Printers Most printers are likely to work.

HP Deskjet 722C Reported by customer.

Epson 750 printer in bidirectional mode Reported by customer.

CARDport Swift Smart Media Digital Image Reported by customer.
Reader/Writer from Chase Advanced Technologies

Logitech Scanman Color 2000 Reported by customer.
(parallel port hand scanner)

Creative Labs WebCam II (parport version) Reported by customer.

Special Notes for the Iomega Zip Drive

On Windows 9x, use of older drivers for the Iomega Zip drive may cause the guest operating 
system to lock up intermittently at boot time or during installation of the guest operating system.
The newest Iomega drivers work reliably in our tests. They are available at
http://www.iomega.com/software/index.html (or use this direct link to the downloadable file: 
http://apps.iomega.com/servlet/dataprocess/driveraccess?database=steerdown&ID=1000000212).
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VMWARE EXPRESS KEYBOARD MAPPING

This document addresses these issues (and some others too): 

• My (language-specific) keyboard is not supported by VMware Express. 

• Some of the keys on my keyboard don't work right in the virtual machine. 

• My keyboard works fine when I run a virtual machine locally, but not when I run the same 

virtual machine with a remote X server. 

Quick Answers

• If your keyboard works correctly with a local X server, and you just want the same behavior 
with a remote X server (which is also an XFree86 server running on a PC), just add the line
xkeymap.usekeycodeMapIfXFree86 = true
to the virtual machine configuration file or ~/.vmware/config (on the host machine, where 
you run the virtual machine, not on the machine with the X server). 

• If you are using an XFree86-based server that VMware Express doesn't recognize as an XFree 
server, use this instead: 
xkeymap.usekey codeMap = true

The Complete Story 

Unfortunately, keyboard support for the PC (virtual or otherwise) is a complex affair. To do it 
justice, we have to start with some (greatly simplified and not strictly correct) background 
information. 

Pressing a key on the PC keyboard generates a scan code based roughly on the position of the 
key. For example, the Z key on a German keyboard generates the same code as the Y key on an
English keyboard, because they are the same key. Most keys have one-byte scan codes, other keys
(with one exception) have two-byte scan codes with prefix 0xe0. Internally, VMware Express uses
a simplified version of the PC scan code that is a single 9-bit numeric value, called v-scan code. 
V-scan codes are written as a three-digit hexadecimal number. The first digit is 0 or 1. For 
example, the left-hand control key has a one-byte scan code (0x1d); its v-scan code is 0x01d.
The right-hand control key scan code is two bytes (0xe0, 0x1d); its v-scan code is 0x11d. 

An X server uses a two-level encoding of keys. An X key code is a one-byte value. The assignment 
of key codes to keys depends on the X server implementation and the physical keyboard. As a
result, an X application normally cannot use key codes directly. Instead, the key codes are
mapped into keysyms that have names like "space," "escape," "x," "2." The mapping can be 
controlled by an X application via XChangeKeyboardMapping() or by the program xmodmap.
Also, xev is a handy tool that shows the key codes and keysyms for the keys typed into its window. 

To recap, a key code corresponds roughly to a physical key, and a keysym corresponds to the 
symbol on the key top. For example, with an XFree86 server running on a PC, the Z key on the
German keyboard has the same key code as the Y key on an English keyboard. The German Z
keysym, however, is the same as the English Z keysym, and different from the Y keysym.

For an XFree86 server on a PC, there is a one-to-one mapping from X key codes to PC scan codes
(or v-scan codes, which is what we really use). VMware Express takes advantage of this fact. When
it is using an XFree86 server on the local host (therefore must be on a PC), then it uses the built-in
mapping from X key codes to v-scan codes. This mapping is keyboard independent, and should be
correct for most (if not all) languages. In other cases (not an XFree86 server or not a local server),
VMware Express must map keysyms to v-scan codes, using a set of keyboard-specific tables.
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Key code mapping is simple, automatic, and foolproof. (Keysym mapping is more complex and
described later.) However, because the program cannot tell whether a remote server is running
on a PC, it errs on the safe side and uses key code mapping only with local X servers. This is often
too conservative and undesirable. Luckily, this and other key code-mapping-related behavior can
be controlled by configuration settings: 

• xkeymap.usekey codeMapIfXFree86 = true
Use key code mapping if using an XFree86 server, even if it is remote. 

• xkeymap.usekey codeMap = true
Always use key code mapping regardless of server type. 

• xkeymap.nokey codeMap = true
Never use key code mapping. 

• xkeymap.key code.<code> = <v-scan code>
If using key code mapping, map key code <code> to <v-scan code>. <code> must be a
decimal number. <v-scan code> should be a C-syntax hexadecimal number (for example, 
0x001). 

The easiest way to find the X key code for a key is to run xev or xmodmap -pk. For v-scan 
codes, try the (incomplete) table at the end of this document. The keysym mapping tables 
described below are also helpful. 

Use this feature to make small modifications to the mapping. For example, do this to swap 
left control and caps lock:
xkeymap.key code.64 = 0x01d  # X Caps_Lock -> VM left ctrl
xkeymap.key code.37 = 0x03a  # X Control_L -> VM caps lock

These configuration lines can be added to the individual virtual machine configuration, to your 
personal VMware Express configuration (~/.vmware/config), or even to the host-wide
(/etc/vmware/config) or installation-wide (usually /usr/local/lib/vmware/config) configuration. 

When key code mapping cannot be used (or is disabled), VMware Express maps keysyms to 
v-scan codes. This is done using one of the tables in the xkeymap directory in the VMware
Express installation (usually /usr/local/lib/vmware). Which table to use depends on the keyboard
layout. The normal distribution includes tables for PC keyboards for the United States and a 
number of European countries and languages. And for most of these, there are both the 101-key
(or 102-key) and the 104-key (or 105-key) variants. 

VMware Express automatically determines which table to use, by examining the current X 
keymap. However, its heuristics may sometimes fail. In addition, each mapping is fixed and may
not be completely right for any given keyboard and X key code-to-keysym mapping. For example,
a user may have swapped control and caps lock using xmodmap. This means the keys will be
swapped in the virtual machine when using a remote server (keysym mapping) but unswapped
when using a local server (key code mapping). 

Therefore, keysym mapping is necessarily imperfect. To make up for this defect, most of the 
behavior can be changed with configuration settings: 

• xkeymap.language = <keyboard-type>
Use this if VMware Express has a table in xkeymap for your keyboard but can't detect it.

<keyboard-type> must be one of the tables in the xkeymap directory. (See above 
for location.) However, the failure to detect the keyboard probably means the table isn't
completely correct for you. 

• xkeymap.keysym.<sym> = <v-scan code>
If using keysym mapping, map keysym <sym> to <v-scan code>. <sym> must be an X keysym
name. <v-scan code> should be a C-syntax hexadecimal number (for example,0x001). 
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The easiest way to find the keysym name for a key is to run xev or xmodmap -pk. The
X header file /usr/X11R6/include/X11/keysymdef.h has a complete list of keysyms. (The name 
of a keysym is the same as its C constant without the XK_ prefix.) For v-scan codes, try the 
(incomplete) table at the end of this document. The xkeymap tables themselves are also 
helpful. Use this feature to fix small errors in an existing mapping. 

• xkeymap.fileName = <file-path>
Use the keysym mapping table in <file-path>.

A table is a sequence of configuration lines of the form
<sym> = <v-scan code>
where <sym> is an X keysym name, and <v-scan code> should be a C-syntax hexadecimal 
number (for example, 0x001). (See xkeymap.keysym above for how to find the keysyms and
v-scan codes for your keyboard.) 

Compiling a complete keysym mapping is hard. It is best to start with an existing table and make 
small changes. 

V-scan Code Table

These are the v-scan codes for the 104-key U.S. keyboard:

Symbol Shifted symbol          Location v-scan code 

Esc 0x001 

1 ! 0x002 

2 @ 0x003 

3 # 0x004 

4 $ 0x005 

5 % 0x006 

6 ^ 0x007 

7 & 0x008 

8 * 0x009 

9 ) 0x00a 

0 ( 0x00b 

- _ 0x00c   

= + 0x00d 

Backspace 0x00e 

Tab 0x00f 

Q 0x010 

W 0x011 

E 0x012 

R 0x013 

T 0x014 

Y 0x015 
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U 0x016 

I 0x017 

O 0x018 

P 0x019 

[ { 0x01a 

] } 0x01b 

Enter 0x01c 

Ctrl (left) 0x01d  

A 0x01e 

S 0x01f 

D 0x020 

F 0x021 

G 0x022 

H 0x023 

J 0x024 

K 0x025 

L 0x026 

; : 0x027 

' "  0x028 

` ~ 0x029 

Shift (left) 0x02a 

\   | 0x02b  

Z 0x02c 

X 0x02d 

C 0x02e 

V 0x02f 

B 0x030 

N 0x031 

M 0x032 

, < 0x033 

. > 0x034   

/ ? 0x035 

Shift (right) 0x036 

* (numeric pad) 0x037 

Alt (left) 0x038 

Space bar 0x039 
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Caps Lock 0x03a 

F1 0x03b 

F2 0x03c 

F3 0x03d 

F4 0x03e 

F5 0x03f 

F6 0x040 

F7 0x041 

F8 0x042 

F9 0x043 

F10 0x044 

Num Lock (numeric pad) 0x045  

Scroll Lock 0x046  

Home 7 (numeric pad) 0x047 

Up arrow 8 (numeric pad) 0x048 

PgUp   9    (numeric pad) 0x049 

- (numeric pad) 0x04a 

Left arrow 4 (numeric pad) 0x04b  

5 (numeric pad) 0x04c 

Right arrow 6 (numeric pad) 0x04d  

+ (numeric pad) 0x04e  

End 1 (numeric pad) 0x04f 

Down arrow 2 (numeric pad) 0x050 

PgDn 3 (numeric pad) 0x051 

Ins 0 (numeric pad) 0x052 

Del (numeric pad) 0x053 

F11 0x057 

F12 0x058 

Break Pause 0x100 

Enter (numeric pad) 0x11c 

Ctrl (right) 0x11d 

/ (numeric pad) 0x135 

SysRq Print Scrn 0x137 

Alt (right) 0x138 

Home (function pad) 0x147 

Up arrow (function pad) 0x148 
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Page Up (function pad) 0x149 

Left arrow (function pad) 0x14b 

Right arrow (function pad) 0x14d 

End (function pad) 0x14f 

Down arrow (function pad) 0x150 

Page Down (function pad) 0x151 

Insert (function pad) 0x152 

Delete (function pad) 0x153 

Windows (left) 0x15b 

Windows (right) 0x15c 

Menu 0x15d 

The 84-key keyboard has a Sys Req on the numeric pad:

Symbol Shifted symbol          Location v-scan code 

Sys Req (numeric pad) 0x054 

Keyboards outside the U.S. usually have an extra key (often < > or < > |) next to the left shift key:

Symbol Shifted symbol          Location v-scan code

< > 0x056 
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Glossary

Bridged networking
A type of network connection between a virtual machine and the rest of the world. Under bridged
networking, a virtual machine appears as an additional computer on the same physical Ethernet
network as the host. 
See also Host-only Networking.

Configuration
See Virtual machine configuration. 

Configuration Editor
A point-and-click editor to view and modify the configuration of a virtual machine. It may be
launched from the Settings menu. 
See also Configuration Wizard. 

Configuration Wizard
A point-and-click interface for convenient, easy creation of a virtual machine configuration. It is
launched automatically when VMware Express is started without specifying a configuration file. It
can also be launched from the VMware Express File menu. It prompts the user for information,
suggesting default values in most cases. At the end it creates files that define the virtual machine,
including a virtual machine configuration file and (optionally) a virtual disk or raw disk file. 
See also Configuration Editor. 

Guest operating system
A Windows 95 or Windows 98 operating system that runs inside a virtual machine. 
See also Host operating system. 

Host-only networking
A type of network connection between a virtual machine and the host. Under host-only network-
ing, a virtual machine is connected to the host on a private network, which normally is not visible
outside the host. Multiple virtual machines configured with host-only networking on the same
host are on the same network. 
See also Bridged networking. 

Host machine
A real, physical computer (as opposed to a virtual machine). 

Host operating system
An operating system that runs on the host machine. 
See also Guest operating system. 

Virtual disk
A virtual disk is a file on the host file system that appears as a physical disk drive to a guest oper-
ating system. This file can be on the host machine as well as on a remote file system. When you
configure a virtual machine with a virtual disk, you can install a new operating system onto the
disk file without the need to repartition a physical disk or reboot the host. VMware Express virtual
disk devices can also be mapped to partitions on the host machine 

Virtual machine
A virtualized x86 PC environment on which a guest operating system and associated application
software can run. Multiple virtual machines can operate on the same host machine concurrently. 
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Virtual machine configuration
The specification of what virtual devices (disks, memory size, etc.) are present in a virtual
machine, and how they are mapped to host files and devices. 

Virtual machine configuration file
A file containing a virtual machine configuration. It is created by the Configuration Wizard or the
Configuration Editor. It is used by VMware Express to identify and run a specific virtual machine.


